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This guide describes how to configure and use webMethods Adapter for IBM Power. It contains
information for administrators and application developers who want to exchange data with IBM
Power systems.

To use this guide effectively, you must be familiar with:

Basic concepts and tasks for working with relational databases.

Creating flow or Java services.

Terminology and basic operations of your operating system .

Setup and operation of webMethods Integration Server.

How to perform basic tasks with Software AG Designer.

Document Conventions

DescriptionConvention

Identifies elements on a screen.Bold

Identifies service names and locations in the format folder.subfolder.service, APIs,
Java classes, methods, properties.

Narrowfont

Identifies:Italic

Variables for which you must supply values specific to your own situation or
environment.
New terms the first time they occur in the text.
References to other documentation sources.

Identifies:Monospace font

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the
information inside the curly braces. Do not type the { } symbols.

{ }

Separates two mutually exclusive choices in a syntax line. Type one of these
choices. Do not type the | symbol.

|

Indicates one or more options. Type only the information inside the square
brackets. Do not type the [ ] symbols.

[ ]

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

...
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Online Information and Support

Product Documentation

You can find the product documentation on our documentation website at https://
documentation.softwareag.com.

In addition, you can also access the cloudproduct documentation via https://www.softwareag.cloud.
Navigate to the desired product and then, depending on your solution, go to “Developer Center”,
“User Center” or “Documentation”.

Product Training

You can find helpful product training material on our Learning Portal at https://
learn.softwareag.com.

Tech Community

You can collaborate with Software AG experts on our Tech Community website at https://
techcommunity.softwareag.com. From here you can, for example:

Browse through our vast knowledge base.

Ask questions and find answers in our discussion forums.

Get the latest Software AG news and announcements.

Explore our communities.

Go to our public GitHub andDocker repositories at https://github.com/softwareag and https://
containers.softwareag.com/products and discover additional Software AG resources.

Product Support

Support for Software AG products is provided to licensed customers via our Empower Portal at
https://empower.softwareag.com. Many services on this portal require that you have an account.
If you do not yet have one, you can request it at https://empower.softwareag.com/register. Once
you have an account, you can, for example:

Download products, updates and fixes.

Search the Knowledge Center for technical information and tips.

Subscribe to early warnings and critical alerts.

Open and update support incidents.

Add product feature requests.
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Data Protection

SoftwareAGproducts provide functionalitywith respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.

webMethods Adapter for IBM Power Installation and User’s Guide 10.11 9



10 webMethods Adapter for IBM Power Installation and User’s Guide 10.11



1 Overview of the Adapter

■   About webMethods Adapter for IBM Power .................................................................... 12

■   Architecture Overview .................................................................................................... 12

■   Package Management .................................................................................................... 13

■   Adapter Connections ...................................................................................................... 14

■   Adapter Services ............................................................................................................ 15

■   Listeners and Notifications ............................................................................................. 19

■   Using Version Control Systems to Manage Adapter Elements ...................................... 19

■   Infrastructure Data Collector Support for webMethods Adapter for IBM Power ............. 20

■   Viewing the Adapter's Update Level ............................................................................... 20

■   Controlling Pagination .................................................................................................... 20

webMethods Adapter for IBM Power Installation and User’s Guide 10.11 11



About webMethods Adapter for IBM Power

webMethods Adapter for IBM Power is an add-on to webMethods Integration Server that enables
you to exchange data with IBM Power systems through the use of IBM ToolBox for Java. The
adapter provides seamless and real-time communicationwith IBMPower systemswithout requiring
changes to your existing application infrastructure.

Using webMethods Adapter for IBM Power, Integration Server clients can create and run services
that retrieve data from dataqueues or insert data into the dataqueues or run commands and
programs in IBM Power systems. webMethods Adapter for IBM Power also provides builtin
services such as pub.ibmp:createDataQueue to create dataqueues in the IBM Power systems.

For example, you can use webMethods Adapter for IBM Power to listen to a dataqueue in IBM
Power system for a new message that is added, and to send that message to Integration Server to
be added into another resource.

For a list of the IBM Power systems versions, drivers, and platforms that webMethods Adapter
for IBM Power supports, see webMethods Adapters System Requirements.

Architecture Overview

webMethodsAdapter for IBMPower provides a set of user interfaces, services, and templates that
enable you to create integrations with IBM Power systems using IBM ToolBox for Java. Ensure
that the supporting drivers are installed and loaded in the packages directory of Integration Server.
For more details, see “Installing webMethods Adapter for IBM Power” on page 22. The adapter
is provided as a single package thatmust be installed on Integration Server. For detailed installation
instructions, see “Overview of Installing, Upgrading, and Uninstalling webMethods Adapter for
IBM Power” on page 22. Because , the For software requirements, see webMethods Adapters System
Requirements. The following diagram describes the different architectural pieces involved in the
integration process:
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webMethods Adapter for IBM Power enables you to configure the following components:

Adapter connections: Enable Integration Server to connect to IBM Power systems at run time.
Youmust configure an adapter connection before you can configure adapter services or adapter
listener and notifications. For a detailed description of adapter connections, see “Adapter
Connections” on page 14.

Adapter services: Enable Integration Server to initiate and perform operations on IBM Power
system. For example, an adapter service could enable a trading partner to check the dataqueue
to determine whether a particular message is published. You configure adapter services using
adapter services templates, which are provided with webMethods Adapter for IBM Power.
For a detailed description of adapter services, see “Adapter Services” on page 15.

Adapter listeners: Monitor a dataqueue, notify Integration Serverwhen an action (not initiated
by Integration Server) occurs on a particular dataqueue, and pass data to Integration Server.
Youmust configure adapter listeners before you configure adapter notifications. For example,
an adapter listener can listen to write operations performed on a dataqueue and notify
Integration Server when the event occurs. For a detailed description of adapter listeners, see
“Listeners” on page 19.

Adapter listener notifications: Enable the adapter to consumedata sent by the adapter listener.
Listener notifications are initiated by events that occur on the dataqueues, not by actions that
occur on Integration Server. With listener and listener notifications, you can capture event
data from the dataqueues and use it to initiate another action within Integration Server. For
example,

Create a listener to monitor the dataqueue.

Create a listener notification.

Trigger a service to publish the data received by the listener notification to Universal
Messaging.

Universal Messaging clients could then subscribe to that data.

Whenever a new message is posted on the dataqueue:

Listener sends an event data to the listener notification.

Listener notification captures the event data in the publishable document.

Listener notification publishes the document to Universal Messaging.

Universal Messaging clients receive the data.

For more information, see “Listener Notifications” on page 19.

Package Management

webMethods Adapter for IBM Power is provided as a package calledWmIBMPowerAdapter that
you manage like any package on Integration Server.
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There are several considerations regarding how you set up and effectively manage your packages
on Integration Server:

You must create user-defined packages for your connections, adapter services, listeners, and
notifications. For details, see “Adapter Package Management” on page 28.

You must understand how package dependencies work so you make the best decisions
regarding how you manage your adapter services and notifications. For details, see “Package
Dependency Requirements and Guidelines” on page 29.

You controlwhich development groups have access towhich adapter services and notifications.
For details, see “Group Access Control” on page 31.

Adapter Connections

webMethods Adapter for IBM Power connects to IBM Power systems through IBM Toolbox for
Java at run time. You create one or more connections at design time to use in integrations. The
number of connections you create, and the types of those connections, depend on the types of
operations you are performing and your integration needs. For example, if you are connecting to
an IBM Power system for dataqueue and command operations, you must create connections that
are unique to those two operations. Additionally, if you have multiple installations of the IBM
Power systems, you access each using different connections. For example, if you have a data
warehouse system and an ERP system that uses your IBM Power system, you create a connection
for each system.

webMethods Adapter for IBM Power connections contain parameters that Integration Server uses
to manage connections to IBM Power system so that they can be used by the adapter to provide
services. You configure connections using Integration Server Administrator. You must have
Integration Server Administrator privileges to access webMethods Adapter for IBM Power's
administrative screens.

For instructions on configuring, viewing, editing, enabling, and disabling webMethods Adapter
for IBM Power connections, see “Overview of Adapter Connections” on page 34. For information
about setting user privileges, see the webMethods Integration Server Administrator’s Guide for your
release.

Connection Pools
Integration Server includes a connectionmanagement service that dynamicallymanages connections
and connection pools based on configuration settings that you specify for the connection. All
adapter services use connection pooling.

A connection pool is a collection of connections with the same set of attributes. Integration Server
maintains connection pools in memory. Connection pools improve performance by enabling
adapter services to re-use open connections instead of opening new connections.

Run-Time Behavior of Connection Pools

When you enable a connection, Integration Server initializes the connection pool, creating the
number of connection instances you specified in the connection's Minimum Pool Size field when
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you configured the connection. Whenever an adapter service needs a connection, Integration
Server provides a connection from the pool. If no connections are available in the pool, and the
maximumpool size has not been reached, the server creates one ormore new connections (according
to the number specified in the Pool Increment Size field) and adds them to the connection pool.
If the pool is full (as specified in Maximum Pool Size field), the requesting service will wait for
Integration Server to obtain a connection, up to the length of time specified in the Block Timeout
field, until a connection becomes available. Periodically, Integration Server inspects the pool and
removes inactive connections that have exceeded the expiration period that you specified in the
Expire Timeout field.

If initialization of the connection pool fails because of a network connection failure or some other
type of exception, you can enable the system to retry the initialization any number of times, at
specified intervals. For information about configuring connections, see “ConfiguringwebMethods
Adapter for IBM Power Connections” on page 34.

Built-In Services for Connections
Integration Server provides built-in services that enable you to programmatically control
connections. You can use them to enable and disable a connection, and to return usage statistics
and the current state (enabled or disabled) and error status for a connection. These services are
located in the WmART package, in the pub.art.connection folder.

The pub.art.service:setAdapterServiceNodeConnection and pub.art.listener:setListenerNodeConnection built-in
services enable you to change the connection associated with an adapter service and adapter
listener respectively. For more information, see “Changing the Connection Associated with an
Adapter Service or Notification at Design Time” on page 17.

For details, see the webMethods Integration Server Built-In Services Reference for your release.

Adapter Services

Adapter services allow you to connect to the IBM Power's resource and initiate an operation on
the resource from Integration Server.

You call adapter services from flow or Java services to interact with IBM Power systems. The
adapter services perform operations by calling IBM ToolBox for Java. Integration Server then uses
adapter connections that you defined earlier to run the adapter services. For details, see “Adapter
Service Transaction Processing” on page 18.

Adapter services are based on templates provided with webMethods Adapter for IBM Power.
Each template represents a specific operation performed on a resource, such as using the Read
DataQueue template to retrieve records from dataqueues in the IBM Power systems.

An adapter service template contains all the code necessary for interacting with the resource but
without the data specifications. You provide these specifications when you create a new adapter
service.

Creating a new service from an adapter service template is straightforward. You assign a default
adapter connection when creating an adapter service. The default adapter connection associated
with the adapter service at designtime is used to run the service unless specified at runtime.
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After you select the connection for the adapter service, you select the adapter service template
and supply the data specifications usingDesigner. Some familiaritywith usingDesigner is required.
For more information, see the webMethods Service Development Help for your release.

webMethods Adapter for IBM Power provides the following adapter service templates:

DescriptionAdapter Service Template

Runs a command in the IBM Power system.Call Command

For instructions about configuring the service,
see “Configuring Call Command Services” on
page 46.

Runs a program in the IBM Power system.Call Program

For instructions about configuring the service,
see “Configuring Call Program Services” on
page 48.

Retrieves records from the specified dataqueue.Read DataQueue

For instructions about configuring the service,
see “Configuring Read DataQueue Services” on
page 51.

Writes records into the specified dataqueue.Write DataQueue

For instructions about configuring the service,
see “ConfiguringWriteDataQueue Services” on
page 53.

Using Adapter Services
The tasks required to use adapter services are:

1. Create an adapter connection using Integration Server Administrator. For more information,
see “Overview of Adapter Connections” on page 34.

2. Select the appropriate adapter service template and configure the adapter service using
Designer. Depending on the type of adapter service, you specify:

Adapter connection

IBM Power system resource (dataqueue, command, program)

Operation to perform that uses a connection object from thewebMethods Adapter for IBM
Power connection pool

Input fields and types as needed

Output fields and types as needed
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For more information about configuring adapter services, see “Overview of Adapter
Services” on page 46.

3. If you plan to use an Integration Server flow or Java service to invoke the adapter service,
design the flow or Java service to use this adapter service using Designer.

4. Manage the adapter service using Designer and Integration Server Administrator. For more
information, see “Overview of Package Management” on page 28, “Overview of Adapter
Services” on page 46, and “Logging Messages Overview” on page 90.

Using a Connection from the Connection Pool Within a Java
or Flow Service
Typically, adapter services use connections from the adapter's connection pool. However, you can
also have any custom Java or flow services that perform operations using webMethods Adapter
for IBM Power connections from the connection pools.

Changing the Connection Associated with an Adapter Service
or Listener at Design Time
Integration Server provides built-in services that you can use at design time to change the connection
associated with an adapter service or notification. The built-in services,
pub.art.service:setAdapterServiceNodeConnection and pub.art.listener:setListenerNodeConnection , are provided
in the WmART package. Using this function, you can change the specific connection associated
with an adapter service or an adapter listener at design time so that you do not need to create and
maintain multiple adapter services and adapter listener.

Note:
The setAdapterServiceNodeConnection and setListenerNodeConnection services can be run at design time
only. Do not use them within an Integration Server flow or Java service. You must run the
services directly from Designer by selecting a service and running it.

For details, see the webMethods Integration Server Built-In Services Reference for your release.

Other built-in services enable you to control connections. For more information, see “Built-In
Services for Connections” on page 15.

Changing the Connection Associated with an Adapter Service
at Run Time
Integration Server enables you to dynamically select the connection a service uses to interact with
IBM Power resources. This feature enables one service to interact with multiple, similar backend
resources.

For example, a service can be defined to use a default adapter connection that interacts with your
company's test dataqueue. However, at run time you can override the default connection and
instead use another connection to interact with the company's production dataqueue.
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Formore information about overriding a service's default connection at run time, see “Dynamically
Changing a Service's Connection at Run Time” on page 39.

Adapter Service Transaction Processing
The following diagram illustrates how webMethods Adapter for IBM Power processes adapter
services at run time.

1. An Integration Server client, typically using a flow or Java service, invokes webMethods
Adapter for IBM Power service on Integration Server to perform an operation on the IBM
Power system resource.

You configured the adapter service earlier using Designer.

2. The adapter service gets a connection from the service's connection pool. Adapter connections
contain connection information for the IBM Power system.

3. The adapter service uses the IBM Toolbox for Java to connect to the IBM Power system.

You created and enabled the adapter connection earlier using Integration ServerAdministrator.

4. Adapter services perform various operations such as reading from andwriting to dataqueues,
calling a command or program.

5. Depending on the adapter service type, such as a ReadDataQueue service, the adapter service
may return data to Integration Server.

If the operation is successful, the service returns the output from the service's operation,
if applicable.

If the operation is unsuccessful, the service returns an error such as an AdapterException.
If IBMPower system throws an exceptionwhile performing the adapter service's operation,
the adapter passes the exception to the Integration Server logs.
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For more information about how the adapter handles exceptions, see “Logging Messages
Overview” on page 90.

Listeners and Notifications

webMethodsAdapter for IBMPower provides listeners and listener notifications to listen forwrite
operations on dataqueues in IBM Power system, notify Integration Server, and process data.

Listeners
webMethodsAdapter for IBMPower listener continuallymonitors a IBMPower system's dataqueue.
When a new record is written to the dataqueue, the listener fetches the record based on the filter
criteria that you select when you configure the listener. The listener passes the record to the listener
notification. You cannot invoke a listener directly from a service or client. Instead, a listener is a
real-time process that you configure, enable, anddisable using the Integration ServerAdministrator.

All the listenerswill stop functioningwhen the package containing the listener node is disabled
or when Integration Server shuts down.

All the enabled listeners will start functioning when the package containing the listener node
is enabled or when Integration Server restarts.

For information about how to configure listeners, see “Configuring Listeners” on page 64.

Listener Notifications
A listener notificationworks in conjunctionwith a listener to process data inwebMethodsAdapter
for IBM Power. When a listener receives data from IBM Power system's dataqueue, then the data
is passed to an enabled listener notification that is associated with the listener.

Important:
The data is lost if you do not configure any listener notifications with the listener, or if you do
not enable any listener notifications which are already configured.

You can configure one or more listener notifications for each listener. If you configure multiple
listener notifications with the same listener, the listener passes the data to the listener notifications
created first. For more information, see “Listener Notifications Overview” on page 72.

Using Version Control Systems to Manage Adapter Elements

The adapter supports the VersionControl System (VCS) Integration feature provided byDesigner.
When you enable the feature in Integration Server, you can check adapter packages or elements
into and out of your version control system from Designer. For more information about the VCS
Integration feature, see Administering the VCS Integration Feature.

Beginning with Integration Server 8.2 SP3, the adapter supports the local service development
feature in Designer. This feature extends the functionality of the VCS Integration feature to check
package elements and their supporting files into and out of a VCS directly from Designer. For
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more information about local service development and how it compares to the VCS Integration
feature, see the webMethods Service Development Help.

Infrastructure Data Collector Support for webMethods Adapter
for IBM Power

Optimize Infrastructure Data Collector monitors the system and operational data associated with
webMethods run-time components such as Integration Servers, UniversalMessaging and adapters,
and reports the status of these components on Optimize Infrastructure Data Collector or other
external tools. When you start monitoring an Integration Server, Infrastructure Data Collector
automatically startsmonitoring allwebMethodsAdapter Runtime-based adapters that are installed
on the Integration Server.

For information about monitored key performance indicators (KPIs) collected for the monitored
adapter components, see the Optimize documentation for your release.

Viewing the Adapter's Update Level

You can view the list of updates that have been applied to the adapter. The list of updates appears
in the Updates field on the adapter's About page in Integration Server Administrator.

Controlling Pagination

You can control the number of items that are displayed on the adapter Connections page and
Notifications page. By default, 10 items are displayed per page. Click Next and Previous to move
through the pages, or click a page number to go directly to a page.

To change the number of items displayed per page, set the watt.art.page.size property and
specify a different number of items.

Perform the following steps to set the number of items per page:

1. From Integration Server Administrator, click Settings > Extended.

2. Click Edit Extended Settings. In the Extended Settings editor, add or update the
watt.art.page.size property to specify the preferred number of items to display per page.
For example, to display 50 items per page, specify:

watt.art.page.size=50

3. Click Save Changes. The property appears in the Extended Settings list.

Formore information aboutworkingwith extended configuration settings, see thewebMethods
Integration Server Administrator’s Guide for your release.
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Overview of Installing, Upgrading, and Uninstalling webMethods
Adapter for IBM Power

This chapter explains how to install, upgrade, and uninstall webMethods Adapter for IBM Power.
The instructions use the Software AG Installer and the Software AG Uninstaller wizards. For
complete information about the wizards or other installation methods, or to install other
webMethods products, see Installing webMethods Products On Premises for your release.

Requirements

For a list of operating systems, drivers, and webMethods products supported by webMethods
Adapter for IBM Power, see webMethods Adapters System Requirements.

webMethods Adapter for IBM Power has no hardware requirements beyond those of its host
Integration Server.

The Integration Server Home Directory

You can create and run multiple Integration Server instances under a single installation directory.
Each Integration Server instance has a home directory under Integration Server_directory\
instances\instance_name that contains the packages, configuration files, log files, and updates
for the instance.

For more information about running multiple Integration Server instances, see the webMethods
Integration Server Administrator’s Guide for your release.

This guide uses the packages_directory as the home directory in Integration Server classpaths.
The packages_directory is Integration Server_directory\instances\instance_name\packagesdirectory.

Installing webMethods Adapter for IBM Power

Perform the following steps to install webMethods Adapter for IBM Power:

1. Download Installer from the Empower Product Support website.

2. If you are installing the adapter on an existing Integration Server, shut down the Integration
Server.

3. Start the Installer wizard.

4. Choose the webMethods release that includes the Integration Server on which you want to
install the adapter. For example, if you want to install the adapter on Integration Server 10.11,
choose the 10.11 release.

5. Specify the installation directory as follows:
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If you are installing on an existing Integration Server, specify the webMethods installation
directory that contains the host Integration Server.

If you are installing both the host Integration Server and the adapter, specify the installation
directory to use.

6. In the product selection list, select Adapters > webMethods Adapter 10.11 for IBM Power.

From the Software AG Installer dialogue box, select the Integration Server > Server 10.11 or
newer.

You can choose to install the package in the default instance. In this case, Software AG Installer
installs the adapter in both locations, Integration Server_directory\packages and the default
instance packages directory located in Integration Server_directory\instances\instance_name\
packages.

7. After the installation completes, close the Installer.

8. Copy the following library files to
Integration Server_directory\instances\instance_name\packages\WmIBMPowerAdapter\code\jars
as webMethods Adapter for IBM Power uses IBM ToolBox for Java to connect to IBM Power
systems:

jt400.jar

util400.jar

9. Start Integration Server.

10. Download the documentation for the adapter, go to Software AG Documentation website.

11. After the installation completes, close the Installer and start the host Integration Server.

Installing webMethods Adapter for IBM Power for Microservices
Runtime

Perform the following steps to install webMethods Adapter for IBMPower inMicroservices
Runtime:

1. Download Installer from the Empower Product Support website.

2. If you are installing the adapter on an existing Integration Server, shut down the Integration
Server.

3. Start the Installer wizard.

4. Specify the installation directory as follows:
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If you are installing on an existing Microservices Runtime, specify the webMethods
installation directory that contains the host Microservices Runtime.

If you are installing both the host Microservices Runtime and the adapter, specify the
installation directory to use.

5. In the product selection list, select Adapters > webMethods Adapter 10.11 for IBM Power.

From the Software AG Installer dialogue box, select theMicroservices Runtime 10.11 or
newer.

6. After the installation completes, close the Installer.

7. Copy the following library files to
Integration Server_directory\instances\instance_name\packages\WmIBMPowerAdapter\code\jars
as webMethods Adapter for IBM Power uses IBM ToolBox for Java to connect to IBM Power
systems:

jt400.jar

util400.jar

8. Start Microservices Runtime.

9. For more information, see Developing Microservices with webMethods Microservices Runtime.

10. Download the documentation for the adapter from Software AG Documentation website.

Upgrading the Adapter

You can upgrade to a newer version of webMethods Adapter for IBM Power.

Before upgrading you can choose to archive the existing adapter package. Archiving creates a
copy of the adapter package which enables you to revert to the earlier adapter package later if
necessary.

Archiving the Adapter Package

Perform the following steps to archive the existing adapter:

1. Navigate to Packages > Management in Integration Server Administrator.

2. Locate WmIBMPowerAdapter and click the icon in the Archive column.

The Archive page is displayed in Integration Server Administrator with the list of all files to
be archived.

By default, Full Archive Type is selected.
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3. Click Create Archive.

Integration Server creates a copy of the adapter package in the Integration Server_directory\
replicate\outbound directory.

Upgrading the Adapter

Perform the following steps to upgrade the adapter:

1. Uninstall the existing adapter and delete the package using the instructions in “Uninstalling
webMethods Adapter for IBM Power” on page 26.

2. Install webMethods Adapter for IBM Power using the instructions in “Installing webMethods
Adapter for IBM Power” on page 22.

Reverting the Adapter to Earlier Versions

Perform the following steps to revert to the earlier version of the adapter:

1. Uninstall the existing adapter and delete the package using the instructions in “Uninstalling
webMethods Adapter for IBM Power” on page 26.

2. Copy the packages_directory\replicate\outbound\WmIBMPowerAdapter to
packages_directory\replicate\inbound directory.

3. Navigate to Packages > Management in Integration Server Administrator.

4. Click Install Inbound Releases.

The Inbound Releases page is displayed in Integration Server Administrator.

5. Select the release file name from the drop-down list and click Install Release.

6. Copy the following library files to
Integration Server_directory\instances\instance_name\packages\WmIBMPowerAdapter\code\jars
as webMethods Adapter for IBM Power uses IBM ToolBox for Java to connect to IBM Power
systems:

jt400.jar

util400.jar

7. Restart Integration Server.
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Uninstalling webMethods Adapter for IBM Power

Perform the following steps to uninstall webMethods Adapter for IBM Power:

1. Shut down the host Integration Server. You do not need to shut down any other webMethods
products or applications that are running on your machine.

2. Start Software AG Uninstaller, selecting the webMethods installation directory that contains
the host Integration Server.

3. In the product selection list, select Adapters > > webMethods Adapter for IBM Power . You
can also choose to uninstall documentation.

4. After Uninstaller completes, restart the host Integration Server.

Uninstaller removesWmIBMPowerAdapter package installed in both Integration Server_directory\
packages directory and Integration Server_directory\instances\default\packages directory.
Uninstaller does not delete other packages youhave created after you installed the adapter including
the files and folders in those packages.
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Overview of Package Management

The following sections describe how to set up and manage your webMethods Adapter for IBM
Power packages, and set up Access Control Lists (ACLs).

Adapter Package Management

webMethods Adapter for IBM Power is provided as a package calledWmIBMPowerAdapter. You
manage the WmIBMPowerAdapter package as you would manage any package on webMethods
Integration Server.

When you create connections, services, listeners, and listeners notifications for webMethods
Adapter for IBM Power, define them in user-defined packages rather than in the
WmIBMPowerAdapter package. Doing so will allow you to manage the package more easily.

As you create user-defined packages inwhich to store connections, services, listeners, and listeners
notifications, use the package management functionality provided in Software AG Designer and
set the user-defined packages to have a dependency on theWmIBMPowerAdapter package. That
way, when the WmIBMPowerAdapter package loads or reloads, the user-defined packages load
automatically. See the following diagram:

Package management tasks include:

Setting package dependencies (see “Package Dependency Requirements and Guidelines” on
page 29)

“Enabling Packages” on page 29

“Importing and Exporting Packages” on page 30
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“Group Access Control” on page 31

Package Dependency Requirements and Guidelines
This section contains a list of dependency requirements and guidelines for user-defined packages.
For instructions for setting package dependencies, see the webMethods Service Development Help
for your release.

A user-defined package must have a dependency on its associated adapter package,
WmIBMPowerAdapter. TheWmIBMPowerAdapter package has a dependency on theWmART
package.

Package dependencies ensure that at startup the Integration Server automatically loads or
reloads all packages in the proper order: theWmART package first, the adapter package next,
and the user-defined packages last. TheWmART package is automatically installedwhen you
install Integration Server. You must not manually reload the WmART package.

If the connections and adapter services of an adapter are defined in different packages, then:

A package that contains the connections must have a dependency on the adapter package.

Packages that contain adapter services must have a dependency on their associated
connection package.

Keep connections for different adapters in separate packages so that you do not create
interdependencies between adapters. If a package contains connections for two different
adapters, and you reload one of the adapter packages, the connections for both adapters will
reload automatically.

Integration Server will not allow you to enable a package if it has a dependency on another
package that is disabled. That is, before you can enable your package, you must enable all
packages on which your package depends. For information about enabling packages, see
“Enabling Packages” on page 29.

Integration Server will allow you to disable a package even if another package that is enabled
has a dependency on it. Therefore, youmust manually disable any user-defined packages that
have a dependency on the adapter package before you disable the adapter package. For
information about disabling packages, see “Disabling Packages” on page 30.

You can name connections, adapter services, and notifications the same name provided that
they are in different folders and packages.

Enabling Packages
When you want to provide access to the elements in a package, you must ensure the package is
enabled. Before the server can access an element in a package, the package must be enabled and
the element must be loaded. All packages are automatically enabled by default. When you enable
a disabled package, the server loads the elements in the package into memory.

Note:
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Enabling an adapter package will not cause its associated user-defined packages to be
reloaded. For information about reloading packages, see thewebMethods Service Development
Help for your release.
Before you manually enable a user-defined package, you must first enable its associated
adapter package (WmIBMPowerAdapter).

Perform the following steps to enable a disabled package:

1. Open Integration Server Administrator if it is not already open.

2. Go to Packages > Management.

3. ClickNo in theEnabled column for the package youwant to enable. The server issues a prompt
to verify that you want to enable the package. Click OK to enable the package.

When the package is enabled, the server displays a and Yes in the Enabled column.

Disabling Packages
When you want to temporarily prohibit access to the elements in a package, disable the package.
When you disable a package, the server unloads all of its elements from memory. Disabling a
package prevents Integration Server from loading that package at startup.

Note:
A disabled adapter will:

Remain disabled until you explicitly enable it using Integration Server Administrator.
Not be listed in Designer.

Perform the following steps to disable a package:

1. Open Integration Server Administrator if it is not already open.

2. Go to Packages > Management.

3. Click Yes in the Enabled column for the package you want to disable. The server issues a
prompt to verify that you want to disable the package. Click OK to disable the package.

When the package is disabled, the server displays a No in the Enabled column.

Importing and Exporting Packages
You import and export packages using Designer. Exporting allows you to export the package to
a .zip file and save it to your hard drive. The ZIP file can then be imported for use by another
package.
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Do not rename packages you export; the rename function is comparable to moving a package,
and when you import the renamed package, you lose any triggers, connections, listeners and
listener notifications associated with this package.

For details about importing and exporting packages, see the webMethods Service Development Help
for your release.

Group Access Control

To control which groups have access to which adapter services, use access control lists (ACLs).
For example, you can use ACLs to prevent one development group from inadvertently updating
the work of another group, or to allow or deny access to services that are restricted to one group
but not to others.

For information about assigning andmanagingACLs, see thewebMethods ServiceDevelopmentHelp
for your release.
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Overview of Adapter Connections

This chapter describes how to configure and manage webMethods Adapter for IBM Power
connections. For more information about how adapter connections work, see “Adapter
Connections” on page 14.

Before Configuring or Managing Adapter Connections

Perform the following steps before configuring or managing adapter connections:

1. Install webMethods Integration Server and webMethods Adapter for IBM Power on the same
machine. For details, see “Overview of Installing, Upgrading, and Uninstalling webMethods
Adapter for IBM Power” on page 22.

2. Make sure you have Integration Server administrator privileges so that you can access
webMethods Adapter for IBM Power's administrative screens. For information about setting
user privileges, see the webMethods Integration Server Administrator’s Guide for your release.

3. Start your Integration Server and Integration Server Administrator, if they are not already
running.

4. Using Integration Server Administrator, make sure the WmIBMPowerAdapter package is
enabled. For instructions, see “Enabling Packages” on page 29.

5. UsingDesigner, create a user-defined package to contain the connection, if you have not already
done so. Formore information aboutmanaging packages for the adapter, see “Adapter Package
Management” on page 28.

6. Copy the following library files to
Integration Server_directory\instances\instance_name\packages\WmIBMPowerAdapter\code\jars
as webMethods Adapter for IBM Power uses IBM ToolBox for Java to connect to IBM Power
systems:

jt400.jar

util400.jar

7. Restart Integration Server.

Configuring webMethods Adapter for IBM Power Connections

When you configure webMethods Adapter for IBM Power connections, you specify information
that Integration Server uses to connect to the IBM Power system. You can configure webMethods
Adapter for IBM Power connections manually using the Integration Server Administrator page.

Perform the following steps to configure an adapter connection:
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1. In theAdaptersmenu in Integration ServerAdministrator's navigation area, clickwebMethods
Adapter for IBM Power.

2. In the Connections page, click Configure New Connection.

3. In the Connection Types page, click webMethods Adapter for IBM Power Connection.

4. In theConfigure Connection Type >webMethods Adapter for IBM Power section, configure
the following fields:

Description/ActionField

Package inwhich to create the connection.UseDesigner to create the package
before specifying the value in this field. For general information about

Package

creating packages, see the webMethods Service Development Help for your
release.

Note:
Configure the connection in a user-defined package rather than in the
adapter's package. For other important considerations when creating
packages for webMethods Adapter for IBMPower, see “Adapter Package
Management” on page 28.

Folder in which to create the connection.Folder Name

Name you want to give to the connection. Connection names cannot have
spaces or use special characters reserved by Integration Server andDesigner.

Connection
Name

For more information about the use of special characters in package, folder,
and element names, see the webMethods Service Development Help for your
release.

5. In the Connection Properties section, use the following fields:

Note:
The following table shows suggested values for these parameters as guidance only. For
more information about what values to assign to these parameters, see your IBM Power
documentation.

Description/ActionField

Type of service representing various ways to
interact with and utilize an IBM Power

Service Type

system's capabilities, such as for data
management, system administration, or other
tasks. The specific usage and functionality can
vary depending on the context and the
software or tools being used to establish the
connections. Possible values are:
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Description/ActionField

COMMAND. Run non-interactive Control
Language(CL) commands or Report
Program Generator (RPG) programs. You
can perform system administration and
automation tasks.

DATAQUEUE. Perform read or write
operations on dataqueues. Dataqueues are
used for asynchronous communication
between programs on the system.

Hostname or IP address of the IBM Power
system.

System Name

Select true to use the default user for the
system name specified in the System Name
field and false to specify the username.

Default System User

Username of the IBM Power system.User ID

Password for the user.Password

Retype the password for the user.Retype Password

Use SSL to connect to the IBM Power system.
Possible values are:

Secure Connection

true. If you have configured SSL
connectionsbetweenwebMethodsAdapter
for IBM Power and IBM Power system, set
the truststore alias name in the
watt.server.ssl.trustStoreAlias server
configuration parameter.

In Integration Server Administrator,
select Settings > Extended.

Set the
watt.server.ssl.trustStoreAlias
server configuration parameter to the
truststore alias name created in
Integration Server.

For information on creating truststore
aliases, see webMethods Integration Server
Administrator’s Guide.

false. Default.
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Description/ActionField

Indicates if the connection is established
through a proxy. Set to true to use the proxy

Proxy

to connect to the IBM Power system. Default
value is false.

Hostname or the IP address and port of the
proxy server in the format serverName[:port].

Proxy Endpoint

If no port is specified, the default port number
is used.

Encrypt data path. Possible values:Proxy Encryption Mode

CLIENT_TO_SERVER. Encrypt data in both,
the connection between the client and the
proxy server, and the connection between
the proxy server and the system.

CLIENT_TO_PROXY_SERVER. Encrypt data on
the connection between the client and the
proxy server.

PROXY_SERVER_TO_SERVER. Encrypt data on
the connection between the proxy server
and the system.

Optional. Library that you want to use for
accessing the IBM Power system resources.

Current Library

The library specified in the Current Library
field is available as %CONN_CURLIB%
environment variable in your service.

Optional. Socket properties which the IBM
Toolbox for Java sets on its client-side sockets.

Socket Properties

Use ; (semi-colons) to delimitmultiple property
settings.

Optional. Property specific to the IBM Power
system resources. Use ; (semi-colons) to delimit
multiple property settings.

Other Properties

Note:
Create a connectionwith COMMAND service type if youwant to use services likeCall Command
or Call Program, and a connection with DATAQUEUE service type if you want to use services
like Read DataQueue or Write DataQueue.

6. In the Connection Management Properties section, use the following fields:
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Description/ActionField

Enables the connection to use connection pooling. For more information
about connection pooling, see “Adapter Connections” on page 14.

Enable
Connection
Pooling

If connection pooling is enabled, this field specifies the number of
connections to createwhen the connection is enabled. The adapterwill keep

Minimum Pool
Size

open the number of connections you configure here regardless of whether
these connections become idle.

If connection pooling is enabled, this field specifies the maximum number
of connections that can exist at one time in the connection pool.

Maximum Pool
Size

If connection pooling is enabled, this field specifies the number of
connections bywhich the poolwill be incremented if connections are needed,
up to the maximum pool size.

Pool Increment
Size

If connection pooling is enabled, this field specifies the number of
milliseconds that Integration Server will wait to obtain a connection with

Block Timeout

the database before it times out and returns an error. For example, you have
a pool with Maximum Pool Size of 20. If you receive 30 simultaneous
requests for a connection, 10 requests will be waiting for a connection from
the pool. If you set the Block Timeout to 5000, the 10 requests will wait for
a connection for 5 seconds before they time out and return an error. If the
services using the connections require 10 seconds to complete and return
connections to the pool, the pending requests will fail and return an error
message stating that no connections are available. If you set the Block
Timeout value too high, you may encounter problems during error
conditions. If a request contains errors that delay the response, other requests
will not be sent. This settingmust be tuned in conjunctionwith theMaximum
Pool Size to accommodate such bursts in processing.

If connection pooling is enabled, this field specifies the number of
milliseconds that an inactive connection can remain in the pool before it is

Expire Timeout

closed and removed from the pool. The connection poolwill remove inactive
connections until the number of connections in the pool is equal to the
Minimum Pool Size. The inactivity timer for a connection is reset when the
connection is used by the adapter.

If you set the Expire Timeout value too high, you may have a number of
unused inactive connections in the pool. This consumes local memory and
a connection on your backend resource. This could have an adverse effect
if your resource has a limited number of connections.

If you set the Expire Timeout value too low, performance could degrade
because of the increased activity of creating and closing connections. This
setting must be tuned in conjunction with the Minimum Pool Size to avoid
excessive opening/closing of connections during normal processing.
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Description/ActionField

Number of times that the system must attempt to initialize the connection
pool at startup if the initial attempt fails. The default is 0.

Startup Retry
Count

Number of seconds that the systemmustwait between attempts to initialize
the connection pool.

Startup Backoff
Timeout

If the connection pooling is enabled and the minimum pool size is more
than zero, theHeart Beat Interval is applicable. The connection pool checks

Heart Beat
Interval

the connectivity of the connections that are idle for the value of Heart Beat
Interval. The default value for Heart Beat Interval is zero and it ismentioned
in seconds. For example, if the value of Heart Beat Interval is 25 seconds,
connection pool looks for connections that are idle for 25 seconds. If a
connection is broken, then the connection pool is reset.

7. Click Save Connection.

The connection you created appears on the adapter's Connections page and in Designer.

You can enable a connection only if the parameters for the connection are valid.

Dynamically Changing a Service's Connection at Run Time

You can run a service using a connection other than the default connection that was associated
with the service when the service was created.

To override the default connection, you must code your flow to pass a value through the pipeline
into a service's $connectionName field.

For example, you have a flow whose primary purpose is to update a production dataqueue.
However, you want the flow to have the capability to update a test dataqueue, with the decision
of which dataqueue to update to be made programmatically at runtime. The output signature of
the flow's first service contains a field called Target. The flow could branch based on the value in
Target. If Target contains the value Production, the second service in the flow would ignore
$connectionName, thus using its default connection to connect to (and then update) the production
dataqueue. However, if Target contains the value Test, the second service in the flow would use
the value in the $connectionName from the pipeline and connect to (and then update) the test
dataqueue.

Keep in mind these restrictions when using dynamic connections:

Both connections, the default and override, must use the same dataqueue structure.

The connection with which you override the default (that is, the value provided for
$connectionName) must be configured to use the same service type as the default connection.

For more information, see “Changing the Connection Associated with an Adapter Service at Run
Time” on page 17.
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Enabling Adapter Connections

An webMethods Adapter for IBM Power connection must be enabled before you can configure
any adapter service using the connection, or before an adapter service can use the connection at
run time. You enable adapter connections using Integration Server Administrator.

Note:
Whenyou reload a package that contains enabled connections, the connectionswill automatically
be enabled when the package reloads. If the package contains connections that are disabled,
they will remain disabled when the package reloads.

Perform the following steps to enable a connection:

1. In the Adapters menu in the Integration Server Administrator navigation area, click
webMethods Adapter for IBM Power.

2. In the Connections page, click No in the Enabled column for the connection you want to
enable.

Integration Server Administrator enables the adapter connection and displays a and Yes in
the Enabled column.

Disabling Adapter Connections

webMethods Adapter for IBM Power connections must be disabled before you can edit or delete
them. You disable adapter connections using Integration Server Administrator.

Perform the following steps to disable a connection:

1. In the Adapters menu in the Integration Server Administrator navigation area, click
webMethods Adapter for IBM Power.

2. In the Connections page, click Yes in the Enabled column for the connection you want to
disable.

The adapter connection is disabled, and you see a No in the Enabled column.

Editing Adapter Connections

If the login information for the IBM Power system changes, or if you want to redefine parameters
that a connectionuseswhen connecting, you canupdate a connection's parameters using Integration
Server Administrator.

Perform the following steps to edit a connection:
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1. In theAdaptersmenu in Integration ServerAdministrator's navigation area, clickwebMethods
Adapter for IBM Power.

2. Make sure that the connection is disabled before editing it. For instructions, see “Disabling
Adapter Connections” on page 40.

3. In the Connections page, click the icon for the connection you want to edit.

The Edit Connection page displays the current parameters for the connection. Update the
connection's parameters by typing or selecting the values you want to specify.

For descriptions of the connection parameters, see “Configuring webMethods Adapter for
IBM Power Connections” on page 34.

4. Click Save Changes to save the connection and return to the Connections page.

Viewing Adapter Connection Parameters

You can view a connection's parameters from Integration Server Administrator and Designer.

Viewing Adapter Connection Parameters Using Integration
Server Administrator
Perform the following steps to view adapter connection parameters in Integration Server
Administrator:

1. In theAdaptersmenu in Integration ServerAdministrator's navigation area, clickwebMethods
Adapter for IBM Power.

The Connections page appears, listing all the adapter connections. You can sort and filter the
list of connections that appears in the Connections page. For more information, see “Sorting
and Filtering Connections” on page 41. You can control the number of connections that are
displayed. For more information, see “Controlling Pagination” on page 20.

2. Click the icon for the connection you want to see.

The View Connection page displays the parameters for the connection. For descriptions of the
connectionparameters, see “ConfiguringwebMethodsAdapter for IBMPowerConnections” on
page 34.

3. Click Return to webMethods Adapter for IBM Power Connections to return to the main
connections page.

Sorting and Filtering Connections
You can sort and filter connections that appear in the Connections page in Integration Server
Administrator. Perform the following steps to sort and filter connections:
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1. In Integration Server Administrator, select Adapters > webMethods Adapter for IBM Power
> Connections.

2. Perform the following to sort the connections:

a. Click the Up and Down arrows on the field you want to sort.

3. Perform the following to filter the connections:

a. Click Filter Connections.

b. Type the criterion by which youwant to filter into the Filter criteria box. Filtering is based
on the connection name. To locate all connections containing specific alphanumeric
characters, use asterisks (*) aswildcards. For example, if youwant to display all connections
containing the string "abc", type *abc* in the Filter criteria box.

c. ClickSubmit. The Connections page displays the connections that match the filter criteria.

d. Click Show All Connections to re-display all connections.

Viewing Adapter Connection Parameters Using Designer
Perform the following steps to view adapter connection parameters in Designer:

1. From the Designer navigation area, open the package and folder in which the connection is
located.

2. Double-click the connection you want to view.

The parameters for the connection appear in the Connection Information. For descriptions
of the connection parameters, see “Configuring webMethods Adapter for IBM Power
Connections” on page 34.

Copying Adapter Connections

You can copy an existing webMethods Adapter for IBM Power connection to configure a new
connection with the same or similar connection properties without having to re-type all of the
properties for the connection. You copy adapter connections using Integration ServerAdministrator.

Perform the following steps to copy a connection:

1. In theAdaptersmenu in Integration ServerAdministrator's navigation area, clickwebMethods
Adapter for IBM Power.

2. In the Connections page, click the icon for the connection you want to copy.
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The Copy Connection page displays the current parameters for the connection you want to
copy. Name the new connection, specify a package name and folder name, and edit any
connection parameters as needed by typing or selecting the values you want to specify.

Note:
When you copy a connection, the new connection does not save the password of the original
connection. You must enter and then retype the password before you can save the new
connection.

For descriptions of the connection parameters, see “Configuring webMethods Adapter for
IBM Power Connections” on page 34.

3. Click Save Connection Copy to save the connection and return to the Connections page.

Deleting Adapter Connections

If you no longer want to use a particular webMethods Adapter for IBM Power connection, you
can delete it. You delete adapter connections using Integration Server Administrator.

If you delete an webMethods Adapter for IBM Power connection, the adapter services or
notifications that are defined to use the connection will no longer work. However, you can assign
a different connection to an adapter service and re-use the service.

Perform the following steps to delete a connection:

1. In the Adapters menu in the Integration Server Administrator navigation area, click
webMethods Adapter for IBM Power.

2. Make sure that the connection is disabled before deleting. To disable the connection, click Yes
in theEnabled columnand clickOK to confirm. TheEnabled columnnow showsNo (Disabled)
for the connection.

3. On the Connections page, click for the connection you want to delete.

Integration Server deletes the adapter connection.
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Overview of Adapter Services

This chapter describes how to configure andmanagewebMethodsAdapter for IBMPower services.
For detailed descriptions of the available webMethods Adapter for IBM Power services, see
“Adapter Services” on page 15.

Before Configuring or Managing Adapter Services

Perform the following steps before configuring or managing adapter services:

1. Start your Integration Server and Integration Server Administrator, if they are not already
running.

2. Make sure you have Integration Server Administrator privileges so that you can access
webMethods Adapter for IBM Power's administrative pages. For information about setting
user privileges, see the webMethods Integration Server Administrator’s Guide for your release.

3. If you have made changes to the dataqueue structure or to the program you are calling, then
be sure to update the adapter service accordingly.

4. Using Integration Server Administrator, make sure the WmIBMPowerAdapter package is
enabled. For instructions, see “Enabling Packages” on page 29.

5. Start Software AG Designer if it is not already running.

6. Using Designer, create a user-defined package to contain the service, if you have not already
done so. When you configure adapter services, you must always define them in user-defined
packages rather than in the WmIBMPowerAdapter package. For more information about
managing packages for the adapter, see “Overview of Package Management” on page 28.

7. Using Integration Server Administrator, configure an adapter connection to use with the
adapter service. For instructions, see “Configuring webMethods Adapter for IBM Power
Connections” on page 34.

Configuring Call Command Services

A Call Command service runs a non-interactive batch command in an IBM Power system. You
can use Call Command service to run commands that do not require user interaction and are often
used for automating administrative tasks or running batch processes in the IBM Power systems.
You can pass parameters or specify the settings required for the batch command. You configure
webMethodsAdapter for IBMPower services usingDesigner. Formore information about adapter
services, see “Adapter Services” on page 15.

Be sure to review the section “Before Configuring or Managing Adapter Services” on page 46
before you configure adapter services.
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Perform the following steps to configure a Call Command service:

1. In Designer, right-click the package in which the service must be created and select New >
Adapter Service.

2. Select the parent namespace, type a name for the adapter service, and click Next.

3. Select webMethods Adapter for IBM Power as the adapter type and click Next.

4. Select the appropriate Adapter Connection Name and click Next.

5. From the list of available templates, select the Call Command template and click Finish.

The adapter service editor for the adapter service appears. You can select theAdapter Settings
tab at any time to confirm adapter service properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template, as necessary.

6. Select the Command tab to configure the command using the fields as follows:

Description/ActionField

Optional. Name of the library where the
command exists. Type the library name or

Library Name

select from the library list (containing user,
system, and other libraries added). Default is
*LIBL.

Name of the command to call. For more
information, see the official website for IBM
Power commands.

Command Name

Description for the command is populated
when you select a command to call.

Command Description

The parameters are auto-populated. You can specify the parameter values required for the
command.

a. Use the icon to create new rows as needed. You can use the icon to fill in all rows to
the table.

b. As you insert rows, the following fields are displayed for each parameter:

Description/ActionField

Name of the parameter to pass when the
command is called.

Parameter Names

webMethods Adapter for IBM Power Installation and User’s Guide 10.11 47

5 Adapter Services



Description/ActionField

Value associated with the parameter. You can
specify the parameter value either in the field

Parameter Values

or during runtime. If you want to provide the
value at runtime, then include a ? in the
Parameter Values field.

c. Use the or icons to change the order of the parameters to ensure that they are parsed
in the correct order.

d. Use the icon to delete a parameter.

7. From the File menu, select Save.

Configuring Call Program Services

ACall Program service runs an IBM Power program in the IBM Power system. You can pass input
parameters to the program and specify output parameters to capture data returned by the program
after it runs. Call Program services are typically used for invoking server programs written in
languages such as RPG or COBOL. You configure webMethods Adapter for IBM Power services
using Designer. For more information about adapter services, see “Adapter Services” on page 15.

Be sure to review the section “Before Configuring or Managing Adapter Services” on page 46
before you configure adapter services.

Perform the following steps to configure a Call Program service:

1. In Designer, right-click the package in which the service must be created and select New >
Adapter Service.

2. Select the parent namespace, type a name for the adapter service, and click Next.

3. Select webMethods Adapter for IBM Power as the adapter type and click Next.

4. Select the appropriate Adapter Connection Name and click Next.

5. From the list of available templates, select the Call Program template and click Finish.

The adapter service editor for the adapter service appears. You can select theAdapter Settings
tab at any time to confirm adapter service properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template, as necessary.

6. Select the Program tab to configure the program using the fields as follows:
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Description/ActionField

Name of the librarywhere the program exists.
Type the library name or select from the library

Library Name

list (containing user, system, and other libraries
added).

Name of the program to call.Program Name

Option to indicate how the program must
respond to inquiry messages. Possible values
are:

Inquiry Message Reply

INQUIRY_MESSAGE_REPLY_DEFAULT. Sends the
default reply message to respond to any
inquiry received while the program is
running. The default reply is either defined
in themessage description or is the default
system reply.

INQUIRY_MESSAGE_REPLY_SYSTEM_REPLY_LIST.
Checks system reply list to see if there is
an entry for an inquiry message issued
while the program is running. If a match
occurs, the system sends the reply value
for that entry. If no entry exists for that
message, the system sends an inquiry
message.

7. Select the Parameters tab to configure the parameters as follows:

a. Use the icon to create new rows as needed.

b. As you insert rows, the following fields are displayed for each input parameter:

Description/ActionField

Name of the input parameter to passwhen the
program is called.

Input Parameter Name

List of IBM Power native data types for the
parameter.

Native Data Type

Length in bytes of the input parameter value.Byte Length

Flag to indicate if the parameter value is an
array.

Is Array
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Description/ActionField

List of possible Java data types depending on
the Native Data Type and the Is Array field
selection.

Input Data Type

Value associated with the parameter. You can
specify the parameter value either in the field

Parameter Value

or during runtime. If you want to provide the
value at runtime, then include a ? in the
Parameter Value field.

You can pass input parameters to the program.

c. As you insert rows, the following fields are displayed for each output parameter:

Description/ActionField

Name of the output parameter returnedwhen
the program is called.

Output Parameter Name

List of IBM Power native data types for the
parameter.

Native Data Type

Flag to indicate if the parameter value is an
array.

Is Array

Number of elements in the array if Is Array is
selected. Default value is 1.

Data Occurrence

List of possible Java data types depending on
the Native Data Type and the Is Array field
selection.

Output Data Type

Length in bytes of the output data value.Output Data Length

You can capture data returned by the program in the output parameters after it runs.

Note:
If you want to specify a parameter as both input and output, add the parameter in the
input section as well as in the output section with the same parameter name.

d. If necessary, use the or icons to change the order of the parameters to ensure that they
are parsed in the correct order.

e. Use the icon to delete a parameter.

8. From the File menu, select Save.
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Configuring Read DataQueue Services

A Read DataQueue service retrieves specified information from an IBM Power dataqueue. You
configure webMethods Adapter for IBM Power services using Designer. For more information
about adapter services, see “Adapter Services” on page 15.

Be sure to review the section “Before Configuring or Managing Adapter Services” on page 46
before you configure adapter services.

Perform the following steps to configure a Read DataQueue service:

1. In Designer, right-click the package in which the service must be created and select New >
Adapter Service.

2. Select the parent namespace, type a name for the adapter service, and click Next.

3. Select webMethods Adapter for IBM Power as the adapter type and click Next.

4. Select the appropriate Adapter Connection Name and click Next.

5. From the list of available templates, select the Read DataQueue template and click Finish.

The adapter service editor appears. You can select the Adapter Settings tab at any time to
confirm adapter service properties such as the Adapter Name, Adapter Connection Name,
and Adapter Service Template, as necessary.

6. Select the Read DataQueue tab to configure the dataqueue using the fields as follows:

Description/ActionField

Name of the library where the dataqueue
exists. Type the library name or select from the

Library Name

library list (containing user, system, and other
libraries added).

Name of the dataqueue from where the
adapter service reads.

Queue Name

Type of read operation. Possible values are:Operation Type

Read. Read a record from the dataqueue
and remove it from the dataqueue. If no
record exists in the dataqueue, then return.

Peek. Read a record from the dataqueue
without removing it from the dataqueue.
If no record exists in the dataqueue, then
return.
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Description/ActionField

Time in seconds to wait if the dataqueue is
empty. Specify -1 to wait until a record
becomes available.

Read Timeout (sec)

Type of dataqueue. Possible values are:Queue Type

Sequential. Dataqueue organized in a
linear or sequential (FIFO or LIFO) order.

Keyed. Dataqueue organized as key-value
pair. The key-value pair allows direct
access to messages based on the specific
identifier (key).

List of the IBM Power native data types in
which the key is stored in the dataqueue if the
Queue Type is Keyed.

Key Type

List of the possible Java data types
corresponding to the Key Type selected, if the
Queue Type is Keyed.

Key Input Type

Length of the key in bytes if the Queue Type
is Keyed.

Key Length

Value of the key if the Queue Type is Keyed.Key Value

Type of comparisons to perform on the Key
Value if the Queue Type is Keyed. Possible
values are:

Key Compare Type

EQ. Equal.

NE. Not equal.

LT. Less than.

LE. Less than or equal.

GT. Greater than.

GE. Greater than or equal.

7. Use the Record Metadata tab to define the metadata and fields to be selected as follows:

a. Use the icon to create new rows as needed.

b. As you insert rows, the following fields are displayed for each Data Name:
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Description/ActionField

Name of the record.Data Name

List of IBM Power native data types for the
record.

Native Data Type

Length in bytes of the data value.Byte Length

Flag to indicate if the data value is an array.Is Array

Number of elements in the array if Is Array is
selected. Default value is 1.

Data Occurrence

List the possible Java data types depending on
the Native Data Type and the Is Array fields
selection.

Output Data Type

c. If necessary, use the or icons to change the order.

d. Use the icon to delete the row.

8. From the File menu, select Save.

Configuring Write DataQueue Services

AWrite DataQueue service inserts new information into an IBM Power dataqueue. You configure
webMethodsAdapter for IBMPower services usingDesigner. Formore information about adapter
services, see “Adapter Services” on page 15.

Be sure to review the section “Before Configuring or Managing Adapter Services” on page 46
before you configure adapter services.

Perform the following steps to configure a Write DataQueue service:

1. In Designer, right-click the package in which the service must be created and select New >
Adapter Service.

2. Select the parent namespace, type a name for the adapter service, and click Next.

3. Select webMethods Adapter for IBM Power as the adapter type and click Next.

4. Select the appropriate Adapter Connection Name and click Next.

5. From the list of available templates, select the Write DataQueue template and click Finish.
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The adapter service editor for the adapter service appears. You can select theAdapter Settings
tab at any time to confirm adapter service properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template, as necessary.

6. Select the Write DataQueue tab to configure the dataqueue using the fields as follows:

Description/ActionField

Name of the library where the dataqueue
exists. Type the library name or select from the

Library Name

library list (containing user, system, and other
libraries added).

Name of the dataqueue to which the adapter
service writes.

Queue Name

Type of dataqueue. Possible values are:Queue Type

Sequential. Dataqueue organized in a
linear or sequential (FIFO or LIFO) order.

Keyed. Dataqueue organized as key-value
pair. The key-value pair allows direct
access to messages based on the specific
identifier (key).

List of the IBM Power native data types in
which the key is stored in the dataqueue, if the
Queue Type is Keyed.

Key Type

List of the possible Java data types
corresponding to the Key Type selected, if the
Queue Type is Keyed.

Key Input Type

Length of the key in bytes if the Queue Type
is Keyed.

Key Length

Value of the key if the Queue Type is Keyed.Key Value

7. Use the Record Data tab to define the record as follows:

a. Use the icon to create new rows as needed.

b. As you insert rows, the following fields are displayed for each Data Name:

Description/ActionField

Name of the record.Data Name
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Description/ActionField

List of IBM Power native data types for the
record.

Native Data Type

Length in bytes of the data value.Byte Length

Flag to indicate if the data value is an array.Is Array

List of possible Java data type corresponding
to the Native Data Type and Is Array fields
selection.

Input Data Type

Value of the record to store in the dataqueue.
You can specify the data value either in the

Data Value

field or during runtime. If the intention is to
provide the value at runtime, then include a ?
in the Data Value field.

c. If necessary, use the or icons to change the order.

d. Use the icon to delete the row.

8. From the File menu, select Save.

Testing Adapter Services

You use Designer to test adapter services.

Formore information about testing and debugging services, see thewebMethods Service Development
Help for your release.

Perform the following steps to test adapter services:

1. In Designer, expand the package and folder that contain the service you want to test.

2. Double-click the service you want to test.

Designer displays the configured service in the service template's Adapter Service Editor.

3. Select Run > Run As > Run Service.

4. Specify how you want to connect to the IBM Power system. If you want to connect to an IBM
Power system using a connection that is different than the connection specified during design
time, specify the connection name here:
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DescriptionParameter

Name of connection to use to connect to the
IBM Power system.

$connectionName

Note:
The service type of the overridden connection must be the same as that of the default
connection. Formore information, see “Changing theConnectionAssociatedwith anAdapter
Service at Run Time” on page 17.

5. If you have defined any other input fields, you will be prompted to type their input values.
Type the values for each input field and then click OK.

6. Click the Service Result tab to view the output from the service.

Viewing Adapter Services

You can view adapter service using Designer.

Perform the following steps to view adapter service:

1. In Designer, expand the package and folder that contains the service you want to view.

2. Double-click the service you want to view.

Designer displays the configured service in the service template's Adapter Service Editor.

Editing Adapter Services

You can edit adapter services using Designer.

Perform the following steps to edit an adapter service:

1. In Designer, expand the package and folder that contains the service you want to edit.

2. Double-click the service you want to edit.

Designer displays the adapter service in the service template's Adapter Service Editor.

3. Do one of the following:

If you have the VCS Integration feature enabled, right-click the service and select Check
Out.

If you do not have the VCS Integration feature enabled, right-click the service and select
Lock for Edit.
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If you are using the local service development feature, from the Team menu in Designer,
select the appropriate option to check out the service. The options available in the Team
menu depend on the VCS client that you use.

4. Modify the values for the adapter service's parameters as needed. For detailed descriptions of
the service's parameters, see the section on configuring a service for the specific type of service
you want to edit.

5. After you complete your modifications, save the service, and do one of the following:

If you have the VCS Integration feature enabled, right-click the service and select Check
In. Enter a check-in comment and click OK.

If you do not have the VCS Integration feature enabled, right-click the service and select
Unlock.

If you are using the local service development feature, from the Team menu in Designer,
select the appropriate option to check in the service. The options available in the Team
menu depend on the VCS client that you use.

6. Save the service.

Deleting Adapter Services

You use Designer to delete adapter services.

Perform the following steps to delete a service:

1. In Designer, expand the package and folder that contains the service you want to delete.

2. Right-click the adapter service and click Delete.

3. Click OK in the Delete Confirmation screen.

Validating Adapter Service Values

Designer enables webMethods Adapter for IBM Power to validate user-defined data for adapter
services at design time. You can validate the values for a single adapter service, or you can configure
Designer to always validate the values for adapter services. Both options could potentially slow
your design-time operations.

If you select the option to always validate values for adapter services, it will do so for all
webMethods WmART-based adapters installed on Integration Server.

For more information about the Adapter Service/Notification Editor and other Designer menu
options and toolbar icons, see the webMethods Service Development Help for your release.
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Validate Data for a Single Adapter Service
Perform the following procedure to validate data for a single adapter service:

1. In Designer, expand the package and folder that contain the service for which you want to
enable automatic validation.

2. Double-click the service for which you want to validate the data.

Designer displays the configured adapter service in the service template's Adapter Service
Editor.

3. Click the icon.

Validating Data for All Adapter Services
Perform the following procedure to enableDesigner to always validate data for all adapter services:

1. In Designer, select the Window > Preferences >Software AG> Service Development >
Adapter Service/Notification Editor item.

2. Enable the Automatic data validation option.

3. Click OK.

Reloading Adapter Values

Designer enables webMethods Adapter for IBM Power to reload and validate user-defined data
for adapter services at design time. You can reload values for a single adapter service, or you can
configure Designer, so it automatically reloads the values for adapter services. Both options could
potentially slow your design-time operations.

When you reload adapter values for a single adapter service, Designer compares the service values
against the resource data that has already been fetched from the selected adapter.

If you select the option to always reload values for adapter services, it will do so for all webMethods
WmART-based adapters installed on Integration Server.

For more information about the Adapter Service/Notification Editor, other menu options, and
toolbar icons, see the webMethods Service Development Help for your release.

Reloading the Values for a Single Adapter Service
Perform the following procedure to reload the adapter values for a single adapter service:

1. In Designer, expand the package and folder that contain the service for which you want to
enable automatic validation.
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2. Double-click the service for which you want to validate the data.

Designer displays the configured adapter service in the service template's Adapter Service
Editor.

3. Click the icon.

Reloading the Values for All Adapter Services
Perform the following procedure to reload the adapter values for all adapter services:

1. In Designer, select the Window > Preferences >Software AG> Service Development >
Adapter Service/Notification Editor item.

2. Enable the Automatic polling of adapter metadata option.

3. Click OK.

webMethods Adapter for IBM Power Installation and User’s Guide 10.11 59

5 Adapter Services



60 webMethods Adapter for IBM Power Installation and User’s Guide 10.11

5 Adapter Services



6 Adapter Listeners and Notifications

■   Listeners Overview ......................................................................................................... 63

■   Before You Configure Listener ........................................................................................ 63

■   Configuring Listeners ..................................................................................................... 64

■   Enabling Listeners .......................................................................................................... 66

■   Suspending Listeners ..................................................................................................... 66

■   Disabling Listeners ......................................................................................................... 67

■   Editing Listeners ............................................................................................................. 67

■   Viewing Adapter Listeners Parameters .......................................................................... 69

■   Copying Listeners ........................................................................................................... 71

■   Deleting Listeners ........................................................................................................... 71

■   Listener Notifications Overview ...................................................................................... 72

■   Before You Configure Listener Notifications ................................................................... 72

■   Dependencies for Listener Notifications ......................................................................... 73

■   Creating a Listener Notification ...................................................................................... 73

■   Configuring a Listener Notification ................................................................................. 74

■   Viewing Adapter Listener Notifications ........................................................................... 76

■   Enabling Listener Notifications ....................................................................................... 77

■   Disabling Listener Notifications ...................................................................................... 78

■   Publishing Listener Notifications Using Integration Server Administrator ....................... 78

■   Testing Listener Notifications .......................................................................................... 78

■   Editing Listener Notifications .......................................................................................... 79

■   Deleting Listener Notifications ........................................................................................ 80

webMethods Adapter for IBM Power Installation and User’s Guide 10.11 61



■   Validating Adapter Listener Notification Values .............................................................. 80

■   Reloading Adapter Values .............................................................................................. 81

62 webMethods Adapter for IBM Power Installation and User’s Guide 10.11

6 Adapter Listeners and Notifications



Listeners Overview

webMethods Adapter for IBM Power provides only one type of listener, which is a dataqueue
listener. A dataqueue listener monitors a specified dataqueue and notifies the application when
awrite operation is performed on the dataqueue. This chapter provides instructions formanaging
dataqueue listener. You must have webMethods Integration Server administrator privileges to
access the webMethods Adapter for IBM Power's administrative screens.

When you configure a dataqueue listener, you must provide information about the IBM Power
dataqueue to monitor.

webMethods Integration Server invokes the listener node every time an entry is written to the
dataqueue and places the dataqueue entry in the pipeline. Listeners are used in conjuntion with
listener notifications. For more details about listener notification, see “Listener Notifications
Overview” on page 72.

Before You Configure Listener

Perform the following before configuring a listener:

1. Install webMethods Integration Server and webMethods Adapter for IBM Power on the same
machine. For details, see “Installing webMethods Adapter for IBM Power” on page 22.

2. Make sure that you have webMethods administrator privileges so that you can access
webMethods Adapter for IBM Power's administrative pages. For information about setting
user privileges, see the webMethods Integration Server Administrator’s Guide for your release.

3. Start Integration Server and Integration Server Administrator, if they are not already running.

4. Using Integration Server Administrator, make sure that the WmIBMPowerAdapter package
is enabled. To verify the status, see “Enabling Packages” on page 29.

5. Start Software AG Designer if it is not already running.

6. Using Designer, create a user-defined package to contain the listener, if you have not already
done so.When you configure listeners, youmust always define them in user-defined packages
rather than in the WmIBMPowerAdapter package. For more information about managing
packages for the adapter, see “Package Management” on page 13.

7. Using Integration Server Administrator, configure an adapter connection to use with the
listener. For instructions, see “Configuring webMethods Adapter for IBM Power
Connections” on page 34.
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Configuring Listeners

When you configure a dataqueue listener, you specify information that the Integration Server uses
to read data from IBM Power dataqueue.

Before you configure the dataqueue listeners, you must configure an adapter connection. You
createwebMethodsAdapter for IBMPower connections using the Integration ServerAdministrator.

Perform the following steps to configure a dataqueue listener:

1. In theAdaptersmenu in Integration ServerAdministrator's navigation area, clickwebMethods
Adapter for IBM Power.

2. Click Listeners.

3. In the Listeners page, click Configure New Listener.

4. In the Listener Types page, select DataQueue Listener.

5. In the Configure Listener Type page, provide values to the following fields:

DescriptionField

Package in which to create the listener. Use
Designer to create the package before

Package

specifying the value in this field. For general
information about creating packages, see the
webMethods Service Development Help for your
release.

Note:
Configure the listener in a user-defined
package rather than in the adapter's
package. For other important considerations
when creating packages for webMethods
Adapter for IBM Power, see “Adapter
Package Management” on page 28.

Folder in which to create the listener.Folder Name

Name of the listener.Listener Name

Name of the webMethods Adapter for IBM
Power connection that the listener must use to
connect to the IBM Power system.

Connection Name

Note:
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DescriptionField

Use a connection with Service Type as
DATAQUEUE to access dataqueues.

Number of times the adapter tries to reconnect,
if the adapter fails to connect to or loses
connection with the IBM Power system.

Retry Limit

Time in seconds thatmust elapse between each
of the retries specified in the Retry Limit.

Retry Backoff Timeout

Name of the library where the dataqueue
exists.

Library Name

Name of the dataqueue which must be
monitored.

Queue Name

Type of dataqueue. Possible values are:Queue Type

Sequential. Dataqueue organized in a
linear or sequential (FIFO or LIFO) order.

Keyed. Dataqueue organized as key-value
pair. The key-value pair allows direct
access to messages based on the specific
identifier (key).

List of the IBM Power native data types in
which the key is stored in the dataqueue if the
Queue Type is Keyed.

Key Type

Length of the key in bytes if the Queue Type
is Keyed. Specify the Key Length as 0 if the
Queue Type is Sequential.

Key Length

Value of the key if the Queue Type is Keyed.Key Value

Type of comparisons to perform on the Key
Value if the Queue Type is Keyed. Possible
values are:

Key Compare Type

EQ. Equal.

NE. Not equal.

LT. Less than.

LE. Less than or equal.

GT. Greater than.

GE. Greater than or equal.
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Note:
The listener name is prefixed by the folder name and is separated by a colon. For example,
if the folder name is Folder1 and the listener name is Listener1, then the listener name in
the Listeners page will be Folder1:Listener1.

6. Click Save Listener. If the parameters are valid, the listener you created appears on the page.

7. To monitor the dataqueue, enable the listener. For more information on enabling listeners, see
“Enabling Listeners” on page 66.

Enabling Listeners

The listener must be enabled to monitor the dataqueue for write operations. When you create a
listener, it is not automatically enabled.

Before you enable a listener, you must configure one or more listener notifications to associate
with the listener. If no notifications are configured when you enable the listener, then Integration
Server Administrator displays a warning message. After you have configured your listener
notifications, you must enable the listener so that the associated listener notifications will
communicate appropriatelywith the listener at runtime. You enable the listeners using Integration
Server Administrator. For more information on configuring listeners and listener notifications,
see the sections on “Configuring Listeners” on page 64 and “Configuring a ListenerNotification” on
page 74.

Note:

You cannot enable a listener if the connection used by the listener is disabled.
When you reload a package that contains enabled listeners, the listeners will automatically
be enabled when the package reloads. If the package contains listeners that are disabled,
they will remain disabled when the package reloads.

Perform the following steps to enable a listener:

1. In theAdaptersmenu in Integration ServerAdministrator's navigation area, clickwebMethods
Adapter for IBM Power.

2. Click Listeners.

3. In the Listeners page, select Enabled in the State column for the listener you want to enable.

Integration Server enables the listener.

4. Click Enable all suspended to quickly enable multiple suspended listeners.

Suspending Listeners

You must be running Integration Server to suspend an enabled listener.
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Note:
A suspended listener acts in the same way as a disabled listener.

Perform the following steps to suspend a listener:

1. In theAdaptersmenu in Integration ServerAdministrator's navigation area, clickwebMethods
Adapter for IBM Power.

2. Click Listeners.

3. In the Listeners page, select Suspended in the State column for the listener you want to
suspend.

Integration Server suspends the listener.

4. Click Suspend all enabled to change the state quickly for multiple enabled listeners.

When you suspend a listener, the action may not take effect right away. You may have to wait. If
one ormore records arewritten to the dataqueuewithin that time interval, the adaptermay receive
and process the first record.

Disabling Listeners

The listeners must be disabled before you can edit or delete them.

Note:
When you disable a connection alias, Integration Server also disables any listener associated
with the connection.

Perform the following steps to disable a listener:

1. In theAdaptersmenu in Integration ServerAdministrator's navigation area, clickwebMethods
Adapter for IBM Power.

2. Click Listeners.

3. In the Listeners page, select Disabled in the State column for the listener you want to disable.

Integration Server disables the listener.

Editing Listeners

You can redefine the parameters that a listener uses when connecting to an IBM Power system
using the Integration Server Administrator.

Note:
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You can edit a listener only if it is disabled. For instructions on disabling a listener, see “Disabling
Listeners” on page 67.

Perform the following steps to edit a listener:

1. In theAdaptersmenu in Integration ServerAdministrator's navigation area, clickwebMethods
Adapter for IBM Power.

2. Click Listeners.

3. In the Listeners page, click the icon for the listener you want to edit.

4. The Edit Listener page displays the parameters for the listener. Update the listener parameters
by typing or selecting the values you want to specify.

The Edit Listener page displays the parameters for the listener. For descriptions of the listener
parameters, see “Configuring Listeners” on page 64.

5. Click Save Changes to save the listener parameters. You will return to the listener page.

Editing Listener Notification Order
You can update the webMethods Adapter for IBM Power listener notification order from the
Integration Server Administrator.

Perform the following to update listener notification order:

1. In theAdaptersmenu in Integration ServerAdministrator's navigation area, clickwebMethods
Adapter for IBM Power.

2. Click Listeners.

The View Listener page appears, listing all the listeners.

3. Click the icon for the listener for which you want to update listener notification order.

Note:
Disable the listener before editing.

4. Click Edit Notification Order.

The listener notifications associated with the listener appear.

5. Select the listener notification and click the Up and Down buttons to change the order.

6. Click Save Changes.
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7. Enable the listener.

Viewing Adapter Listeners Parameters

You can view a listener's parameters from Integration Server Administrator and Designer. You
can also view the listener notification order of a listener.

Viewing Adapter Listener Parameters Using Integration Server
Administrator
You can view the webMethods Adapter for IBM Power listener from the Integration Server
Administrator.

Perform the following steps to view the parameters of a listener:

1. In theAdaptersmenu in Integration ServerAdministrator's navigation area, clickwebMethods
Adapter for IBM Power.

2. Click Listeners.

The Listener page appears, listing all the listeners. You can perform the following:

Control the number of listener notifications that are displayed. For more information, see
“Controlling Pagination” on page 20.

Sort and filter the listeners. For more information, see “Sorting and Filtering Listeners” on
page 69.

Enable and disable the listeners. Formore information, see “Enabling Listeners” on page 66
and “Disabling Listeners” on page 67.

View listener notification order. For more information, see “Viewing Listener Notification
Order” on page 70.

3. In the Listeners page, click the icon for the listener you want to see.

The ViewListener page displays the parameters for the listener. For descriptions of the listener
parameters, see “Configuring Listeners” on page 64.

4. Click Return to webMethods Adapter for IBM Power Listeners to return to the main
connections page.

Sorting and Filtering Listeners
You can sort and filter the list of listener that appear on the Listeners page in Integration Server
Administrator.

Perform the following to sort and filter listener:
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1. In Integration Server Administrator, select Adapters > webMethods Adapter for IBM Power
> Listeners.

2. Perform the following to sort the listener:

a. Click the Up and Down arrows on the field you want to sort.

3. Perform the following to filter the listeners:

a. Click Filter Listener.

b. Type the criterion by which youwant to filter into the Filter criteria box. Filtering is based
on the listener name. To locate all listeners containing specific alphanumeric characters,
use asterisks (*) as wildcards. For example, if you want to display all listeners containing
the string "abc", type *abc* in the Filter criteria box.

c. Click Submit. The Listeners page displays the listeners that match the filter criteria.

d. Click Show All Listeners to re-display all listeners.

Viewing Listener Notification Order
You can view the webMethods Adapter for IBM Power listener notification order from the
Integration Server Administrator.

Perform the following to view the order in which listener notifications receive data from a
listener:

1. In theAdaptersmenu in Integration ServerAdministrator's navigation area, clickwebMethods
Adapter for IBM Power.

2. Click Listeners.

The View Listener page appears, listing all the listeners.

3. Click the icon for the listener for which you want to view listener notification order.

4. Click View Notification Order.

The listener notifications associated with the listener appear.

5. Click Return to View Listener to return to the View Listener page.

Viewing Listener Parameters Using Designer
Perform the following steps to view listener parameters in Designer:
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1. From theDesigner navigation area, open the package and folder inwhich the listener is located.

2. Double-click the listener you want to view.

The parameters for the listener appear in the Listener Information. For descriptions of the
listener parameters, see “Configuring Listeners” on page 64.

Copying Listeners

You can copy an existing listener to configure a new listener with the same or similar listener
propertieswithout having to re-type all of the properties for the listener. You copy adapter listener
using Integration Server Administrator.

Perform the following steps to copy a listener:

1. In theAdaptersmenu in Integration ServerAdministrator's navigation area, clickwebMethods
Adapter for IBM Power.

2. Click Listeners.

3. In the Listeners page, click the icon for the listener you want to copy.

4. The Copy Listener page displays the parameters for the listener. Update the listener name and
parameters by typing or selecting the values you want to change.

The Copy Listener page displays the parameters for the listener. For descriptions of the listener
parameters, see “Configuring Listeners” on page 64.

5. Click Save Listener Copy to save the listener parameters. Youwill return to the listener page.

Deleting Listeners

If you no longer want to use a particular listener, you can delete it. You delete adapter listeners
using Integration Server Administrator.

Note:
You can delete a listener only if the listener is disabled. For instructions on disabling a listener,
see “Disabling Listeners” on page 67.

Perform the following steps to delete a listener:

1. In theAdaptersmenu in Integration ServerAdministrator's navigation area, clickwebMethods
Adapter for IBM Power.

2. Click Listeners.
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3. In the Listeners page, click the icon for the listener you want to delete.

Integration Server deletes the listener and redirects to the listener page.

Listener Notifications Overview

The following sections provide instructions for creating, configuring and managing the listener
notifications.webMethodsAdapter for IBMPower provides one type of listener notification,which
is a DataQueue Listener Notification. A listener notification works in conjunction with a listener
to process data in webMethods Adapter for IBM Power. When a listener receives data from IBM
Power dataqueue, then it passes the data to an enabled listener notification that is associated with
the listener.

Important:
The data is lost if you do not configure any listener notifications with the listener, or if you do
not enable any listener notifications which are already configured. Software AG recommends
that you enable a listener notification before you enable the listener.

Ideally, you must configure only one notification per listener. If you configure multiple listener
notifications with the same listener, the listener passes the data to the listener notifications created
first. You can view and edit the order in which the listener notifications receive the data from the
listener. Formore information, see “Editing ListenerNotificationOrder” on page 68 and “Viewing
Listener Notification Order” on page 70. If you have configured multiple notifications with a
listener, Software AG recommends that you enable only the notification that needs to be executed.

Before You Configure Listener Notifications

Perform the following steps before configuring a listener notification:

1. Install webMethods Integration Server and webMethods Adapter for IBM Power on the same
machine. For details, see “Installing webMethods Adapter for IBM Power” on page 22.

2. Make sure that you have webMethods administrator privileges so that you can access
webMethods Adapter for IBM Power's administrative screens. For more information about
setting user privileges, seewebMethods Integration Server Administrator’s Guide for your release.

3. Start Integration Server and Integration Server Administrator, if they are not already running.

4. Using Integration Server Administrator, make sure that the WmIBMPowerAdapter package
is enabled. To verify the status, see “Enabling Packages” on page 29.

5. Start Software AG Designer if it is not already running.

6. Using Designer, create a user-defined package to contain the listener and listener notification,
if you have not already done so. Formore information aboutmanaging packages, see “Package
Management” on page 13.
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7. Using Integration Server Administrator, configure an adapter connection to use with the
listener. For instructions, see “Configuring webMethods Adapter for IBM Power
Connections” on page 34.

8. Configure a listener using Integration Server Administrator. For more information on how to
configure a new listener, see “Configuring Listeners” on page 64.

Dependencies for Listener Notifications

The following is a list of other objects youmust configure or tasks youmust complete to use listener
notifications:

1. Configure an adapter connection using Integration ServerAdministrator. Formore information,
see “Configuring webMethods Adapter for IBM Power Connections” on page 34.

2. Configure a listener using Integration ServerAdministrator. Formore information, “Configuring
Listeners” on page 64.

3. Select the appropriate notification template and create the listener notification using Designer.
For more information, see “Creating a Listener Notification” on page 73 and “Configuring a
Listener Notification” on page 74.

4. Create an Integration Server trigger that subscribes to the document type that webMethods
Adapter for IBM Power created with the notification using Designer. For more information
about using triggers, see webMethods Service Development Help.

5. Enable the listener using Integration ServerAdministrator. Formore information, see “Enabling
Listeners” on page 66.

6. Enable the listener notifications using Integration Server Administrator. Formore information,
see “Enabling Listener Notifications” on page 77.

Creating a Listener Notification

Perform the following steps to create a listener notification:

1. In Software AG Designer, select the parent namespace.

2. Select New > Adapter Notification and type a name for the adapter notification. Click Next.

3. Select webMethods Adapter for IBM Power as the adapter type and click Next.

4. From the list of available templates, select DataQueue Listener Notification and click Next.

5. Select the appropriate Notification Listener Name and click Next.

Note:
You must select an enabled listener to create a listener notification.
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6. Select the Publish Document Name and click Finish.

The Adapter Notification template creates the following items:

A listener notification.

A document type to publish.

Configuring a Listener Notification

Perform the following steps to configure a listener notification:

1. Start Software AG Designer.

2. In the adapter notification service editor for the notification you just created, select theAdapter
Settings tab.

3. Use the DataQueue Listener Notification tab to define the metadata and fields to receive as
follows:

a. Use the icon to create new rows as needed.

b. As you insert rows, the following fields are displayed for each Data Name:

Description/ActionField

Name of the record.Data Name

List of IBM Power native data types for the
record.

Native Data Type

Length in bytes of the data value.Byte Length

Flag to indicate if the data value is an array.Is Array

Number of elements in the array if Is Array is
selected. Default value is 1.

Data Occurrence

List the possible Java data types depending on
the Native Data Type and the Is Array fields
selection.

Output Data Type

c. If necessary, use the or icons to change the order.

d. Use the icon to delete the row.

4. Review the Publish Document Name and click Finish.
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5. In the Adapter Settings tab, confirm the adapter name, adapter listener name, and adapter
notification template.

The following items items are created:

A listener notification

A publishable document

6. Perform one of the following procedures:

In the Publish Document to area, select webMethods Messaging Provider.

To publish document to the Universal Messaging connected to the local Integration
Server:

1. Select IS_UM_CONNECTION.

This option publishes documents to Universal Messaging connected to local
Integration Server, if one is configured. For more information about publishing to
Universal Messaging, see the webMethods Integration Server Administrator’s Guide
for your release.

To publish document to local Integration Server:

1. Select IS_LOCAL_CONNECTION.

2. Create a matching local webMethods Messaging Trigger trigger to process the
request document locally or at a remote Integration Server connected to this
Integration Server byway of aUniversalMessaging. Configure the trigger to ensure
that thematching reply document is returned to this adapter notification. Formore
information about this step, see the webMethods Service Development Help for your
release.

In the Publish Document to area, select JMS Provider to publish the document to
internal/external JMS provider in the form of messages:

1. Click the Browse button next to Connection alias name to select the name of the
connection alias as it is configured in Integration Server and then click OK.

2. Type the destination name defined in the JMS provider to specify the target ofmessages
the client produces and the source of messages it consumes.

3. Specify whether the destination is a Queue or a Topic. The default is Queue.

For more information about configuring JMS Provider, see webMethods Integration Server
Administrator’s Guide for your release.

7. Select the Permissions tab to manage the access control list (ACL) information. Use the
drop-down menu to select each of the ACL types. For general information about assigning
and managing ACLs, see the webMethods Service Development Help for your release.

8. From the File menu, select Save (or Save All).
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Viewing Adapter Listener Notifications

You can view a listener notification's parameters fromDesigner. In Integration ServerAdministrator
you can list, enable, disable and publish events for the listener notifications.

Viewing Listener Notifications Using Integration Server
Administrator

Perform the following steps to view listener notifications using Integration Server
Administrator:

1. In the Adapters menu in the navigation area of Integration Server Administrator, click
webMethods Adapter for IBM Power.

2. Click Listener Notifications.

The Listener Notifications page appears, listing all the listener notifications. You can perform
the following:

Control the number of listener notifications that are displayed. For more information, see
“Controlling Pagination” on page 20.

Sort and filter the listener notifications. For more information, see “Sorting and Filtering
Listener Notifications” on page 76.

Enable and disable the listener notifications. For more information, see “Enabling Listener
Notifications” on page 77 and “Disabling Listener Notifications” on page 78.

Note:
You cannot publish events. For more information, see “Publishing Listener Notifications
Using Integration Server Administrator” on page 78.

3. Click Return to webMethods Adapter for IBM Power Connections to return to the main
connections screen.

Sorting and Filtering Listener Notifications
You can sort and filter the list of listener notifications that appear on the Listener Notifications
screen in Integration Server Administrator.

Perform the following steps to sort and filter listener notifications:

1. In Integration Server Administrator, select Adapters > webMethods Adapter for IBM Power
> Listener Notifications.

2. Perform the following steps to sort the listener notifications:
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a. Click the Up and Down arrows on the field you want to sort.

3. Perform the following steps to filter the listener notifications:

a. Click Filter Listener Notifications.

b. Type the criterion by which youwant to filter into the Filter criteria box. Filtering is based
on the listener notification name. To locate all listener notifications containing specific
alphanumeric characters, use asterisks (*) as wildcards. For example, if youwant to display
all listener notifications containing the string "abc", type *abc* in the Filter criteria box.

c. ClickSubmit. The ListenerNotifications page displays the listener notifications thatmatch
the filter criteria.

d. Click Show All Listener Notifications to re-display all listener notifications.

Viewing Listener Notifications Using Designer

Perform the following steps to view listener notifications using Designer:

1. In Designer, expand the package and folder that contains the listener notification you want to
view.

2. Select the listener notification that you want to view.

The adapter's Adapter Notification Editor displays details about the configured listener
notification. You can also view the publishable document associatedwith the listener notification
using Designer.

Enabling Listener Notifications

After you configure a listener notification, you need to enable it using Integration Server
Administrator.

Perform the following steps to enable a listener notification:

1. In the Adapters menu in the Integration Server Administrator navigation area, click
webMethods Adapter for IBM Power.

2. Select Listener Notifications.

3. In the Listener Notifications page, click No in the Enabled column for the listener notification
you want to enable.

The listener notification is enabled and a and Yes is displayed in the Enabled column.
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Disabling Listener Notifications

You disable listener notifications using Integration Server Administrator.

Perform the following steps to disable a listener notification:

1. In the Adapters menu in the Integration Server Administrator navigation area, click
webMethods Adapter for IBM Power.

2. In webMethods Adapter for IBM Power menu, select Listener Notifications.

3. On the ListenerNotifications page, clickYes in theEnabled column for the listener notification
you want to disable.

The listener notification is disabled and No is displayed in the Enabled column.

Publishing Listener Notifications Using Integration Server
Administrator

Publish events is not supported in webMethods Adapter for IBM Power. An error is displayed if
you click on No in the Publish Events column for the listener notification you want to publish
event.

Testing Listener Notifications

You can test listener notifications to ensure that you have configured them correctly.

Perform the following steps to test listener notifications:

1. Configure a listener using Integration Server Administrator. For instructions to configure a
listener, see “Before You Configure Listener” on page 63.

2. Configure a listener notification using Designer. For instructions to configure a notification,
see “Configuring a Listener Notification” on page 74.

3. Enable the listener notification using Integration Server Administrator. For instructions to
enable a listener notification, see “Enabling Listener Notifications” on page 77.

4. Enable the listener using Integration Server Administrator. For instructions to enable a listener,
see “Enabling Listeners” on page 66.

5. FromyourDesigner, invoke an adapter service towrite to dataqueuewhich is beingmonitored.
The listener will receive a request and will forward the request to the matching notification.
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Editing Listener Notifications

You use Designer to edit listener notifications. When editing the listener notification, you can also
edit the publishable document type associatedwith the listener notifications. Listener notifications
must be disabled before you can edit or delete them.

Perform the following steps to edit a listener notification:

1. In Designer, expand the package and folder that contains the listener notification you want to
edit.

2. Select the listener notification you want to edit.

The adapter's Adapter Notification Editor displays details about the configured listener
notification.

3. Use the DataQueue Listener Notification tab to define the metadata and fields to be selected
as follows:

a. Use the icon to create new rows as needed.

b. As you insert rows, the following fields are displayed for each Data Name:

Description/ActionField

Name of the record.Data Name

List of IBM Power native data types for the
record.

Native Data Type

Length in bytes of the data value.Byte Length

Flag to indicate if the data value is an array.Is Array

Number of elements in the array if Is Array is
selected. Default value is 1.

Data Occurrence

List the possible Java data types depending on
the Native Data Type and the Is Array fields
selection.

Output Data Type

c. If necessary, use the or icons to change the order.

d. Use the icon to delete the row.

4. In the Adapter Settings tab, you can update the destination to publish the document. Formore
information, see “Configuring a Listener Notification” on page 74.
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Note:
You can change a listener for a listener notification after you configure it using
pub.art.notification:setListenerNotificationNodeListener built-in service provided byWmARTpackage.

5. From the File menu, select Save (or Save All).

Deleting Listener Notifications

If you no longerwant to use a particularwebMethodsAdapter for IBMPower listener notification,
you can delete it by following the instructions in this section. You delete listener notifications using
Designer. Listener notifications must be disabled before you can edit or delete them.

Important:

If you delete a listener notification, the associated publishable document type is deleted
automatically.
You cannot solely delete the document types associated with the listener notifications.

Perform the following steps to delete a listener notification:

1. In Designer, expand the package and folder that contain the listener notification you want to
delete.

2. Right-click the listener notification and click Delete.

Validating Adapter Listener Notification Values

Designer enables webMethods Adapter for IBM Power to validate user-defined data for adapter
listener notifications at design time. You can validate the values for a single listener notification,
or you can configure Designer to always validate the values for listener notifications. Both options
could potentially slow your design-time operations.

When you enable data validation for a single listener notification, Designer compares the listener
notification values against the resource data that has already been fetched from the selected adapter.

If you select the option to always validate values for listener notifications, it will do so for all
webMethods WmART based adapters installed on Integration Server.

For more information about the Adapter Service/Notification Editor and other Designer menu
options and toolbar icons, see the webMethods Service Development Help for your release.

Validate Data for a Single Listener Notification
Perform the following procedure to validate data for a single listener notification:

1. In Designer, expand the package and folder that contain the listener notification for which you
want to enable automatic validation.
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2. Double-click the listener notification for which you want to validate the data.

Designer displays the configured listener notification in the service template's Adapter
Notification Editor.

3. Click the icon.

Validating Data for All Listener Notifications
Perform the following steps to enableDesigner to always validate data for all listener notifications:

1. In Designer, select the Window > Preferences >Software AG> Service Development >
Adapter Service/Notification Editor item.

2. Enable the Automatic data validation option.

3. Click OK.

Reloading Adapter Values

Designer enables webMethods Adapter for IBM Power to reload and validate user-defined data
for listener notifications at design time in . You can reload values for a single listener notification,
or you can configure Designer to automatically reload the values for listener notifications. Both
options could potentially slow your design-time operations.

When you reload adapter values for a single listener notification, Designer compares the listener
notification values against the resource data that has already been fetched from the selected adapter.

If you select the option to always reload values for listener notifications, it will do so for all
webMethods WmART-based adapters installed on Integration Server.

For more information about the Adapter Service/Notification Editor, other menu options, and
toolbar icons, see the webMethods Service Development Help for your release.

Reloading the Values for a Single Listener Notification
Perform the following procedure to reload the adapter values for a single listener notification:

1. In Designer, expand the package and folder that contain the listener notification for which you
want to enable automatic validation.

2. Double-click the listener notification for which you want to validate the data.

Designer displays the configured listener notification in the service template's Adapter
Notification Editor.

3. Click the icon.
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7 Predefined Health Indicator
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Predefined Health Indicator

Microservices Runtime includes predefined health indicators for some of its basic components.
The health indicator captures the connection details for all theWmART-based adapters at runtime.
For more information, see webMethods Adapter Runtime User's Guide.
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Administrator APIs

The Administrator APIs are available for webMethods Adapter for IBM Power. For more
information about Administrator APIs and samples, seewebMethods Adapter RuntimeUser's Guide.
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Configuration Variables Templates for Adapter Assets in
Microservices Runtime

ThewebMethodsAdapter Runtime (ART) asset properties that can be configured from Integration
ServerAdministrator are available in the configuration variables template (application.properties
file) generated by Microservices Runtime. For more information, see webMethods Adapter Runtime
User's Guide and Developing Microservices with webMethods Microservices Runtime.
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Logging Messages Overview

This chapter describes the logging information, exception handling, andmonitoring ofwebMethods
Adapter for IBM Power connection statistic and performance.

Logging Messages

The webMethods Adapter for IBM Power uses the Integration Server's logging mechanism to log
messages. You can configure and view the Integration Server's logs to monitor and troubleshoot
thewebMethodsAdapter for IBMPower. For detailed information about logging in the Integration
Server, including instructions for configuring and viewing the different kinds of logs supported
by the server, see the webMethods Audit Logging Guide for your release.

Adapter Message Logging
Integration Server maintains several types of logs; however, webMethods Adapter for IBM Power
only logs messages to the audit, error and server logs. Because webMethods Adapter for IBM
Power works in conjunction with the WmART package, the adapter's messages and exceptions
typically appear within log messages for the WmART package.

The logging levels for webMethods Adapter for IBM Power are given in the following table.

DescriptionLog

You can monitor individual adapter services
using the audit log as you would audit any

Audit Log

service in Integration Server. The audit
properties for an adapter service are available in
each webMethods Adapter for IBM Power
service template on the Audit tab.

webMethods Adapter for IBM Power
automatically posts fatal-level and error-level

Error Log

log messages to the server's error log. These log
messages will appear as adapter run-time
messages.

webMethods Adapter for IBM Power posts
messages to the server log, depending on how

Server Log

the server log is configured. Fatal-level through
debug-level log messages appear as adapter
run-time logmessages. Trace-level logmessages
appear as webMethods Adapter for IBM Power
log messages.

The adapters log messages appear in either of the following formats:

ADA.512.nnnnc
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ADA.0512.nnnnc

where the facility code ADA indicates that the message is from an adapter, 0512 or 512 indicates
that it is webMethods Adapter for IBM Power, nnnn represents the error's minor code, and
(optionally) c represents the message's severity level.

Tomonitor webMethodsAdapter for IBMPower's logmessages in the server log, ensure that your
server log's logging settings are configured to monitor the following facilities:

0113 Adapter Run time (Managed Object)

0114 Adapter Run time

0115 Adapter Run time (Listener)

0116 Adapter Run time (Notification)

0117 Adapter Run time (Adapter Service)

0118 Adapter Run time (Connection)

0121 Adapter Run time (SCC Transaction Manager)

0126 Adapter Run time (SCC Connection Manager)

Accessing Adapter Logging Levels
You can configure different logging levels for webMethods Adapter for IBM Power in Integration
Server using Integration Server Administrator.

Perform the following steps to access the adapter's logging information:

1. In Integration Server Administrator page, do the following: .

Select Settings > Logging in the old Integration Server Administrator UI.

Select Logs > Logging configuration in the new Integration Server Administrator UI.

The Logger List appears.

2. Select Server Logger. The View server logger details page appears displaying the facility
and the logging level for that facility.

3. In View server logger details page, expand the Adapters tree to see a list of all installed
adapters with their code number, adapter description, along with the logging level for the
adapter.

Changing Logging Levels
You can change the logging levels for webMethods Adapter for IBM Power in Integration Server
using Integration Server Administrator.
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Perform the following steps to change logging levels for the adapter:

1. In Integration Server Administrator page, do the following:

Select Settings > Logging.

Select Logs > Logging configuration.

The Logger List appears.

2. Select Server Logger. The View server logger details page appears displaying the facility
and the logging level for that facility.

3. In View server logger details page, expand the Adapters tree to see a list of all installed
adapters with their code number, adapter description, along with the logging level for the
adapter.

4. Click Edit Server Logger.

5. Expand the Adapters tree.

6. Select the required Logging Level for webMethods Adapter for IBM Power.

7. Update the Log Timestamp Format as per your requirement.

8. After making your changes, click Save Changes.

9. For complete information about the log levels and type of information to include in the log,
see the webMethods Audit Logging Guide for your release.

92 webMethods Adapter for IBM Power Installation and User’s Guide 10.11

10 Adapter Logging



Built-In Services

pub.ibmp:createDataQueue

Creates a sequential or keyed dataqueue in the IBM Power system.

Input Parameters

DescriptionParameter Name

String. Required. Fully qualified connection
name of the IBM Power system.

$connectionAlias

String. Required. Name of the dataqueue. The
dataqueue name must be 1 to 10 characters. For
example, MYQUEUE.

queueName

String. Required. Library inwhich the dataqueue
must be created. The libraryNamemust be 1 to
10 characters.

libraryName

String. Required. Dataqueue type. Possible
values are:

queueType

FIFO. Processes records in a sequential order
of First In, First Out (FIFO) in the dataqueue.

LIFO. Processes records in a sequential order
of Last In, First Out (LIFO) in the dataqueue.

Keyed. Processes records as a key-value pair
in the dataqueue.

String. Optional. Length of the key in bytes if
the queueType is Keyed. Valid values are 1 to 256.

keyLength

String. Required. Maximum number of bytes
per dataqueue entry. Valid values are 1 to 64512.

maxEntryLength

String. Required. Public authority for the
dataqueue. Valid values are *ALL, *CHANGE,
*EXCLUDE, *USE, *LIBCRTAUT.

authority

String. Optional. Default value is false. Set to
true if the sender (origin) information of the
records must be saved.

saveSenderInformation

String. Optional. Default value is false. Set the
value to true to immediately write the records

forceToAuxiliaryStorage

to a permanent storage. Set the value to false to

webMethods Adapter for IBM Power Installation and User’s Guide 10.11 93



DescriptionParameter Name

keep the records to write in memory, which
could be lost in the case of a power outage.

String. Required. Text description of the
dataqueue. String must be 50 characters or less.

description

Output Parameters

DescriptionParameter Name

String. Status of the service execution. Returns
true if the dataqueue is successfully created, else
returns false.

success

String. Error message if the dataqueue creation
fails.

error

pub.ibmp:getDefaultUser

Returns the default user ID for the system name specified in $connectionAlias.

Input Parameters

DescriptionParameter Name

String. Required. Fully qualified connection
name of the IBM Power system.

$connectionAlias

Output Parameters

DescriptionParameter Name

String. Default user ID for the system name
specified in $connectionAlias.

userId

String. Error message if the service fails.error

pub.ibmp:removeDefaultUser

Removes the default user for the system name specified in $connectionAlias.
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Input Parameters

DescriptionParameter Name

String. Required. Fully qualified connection
name of the IBM Power system.

$connectionAlias

Output Parameters

DescriptionParameter Name

String. Status of the service execution. Returns
true if the service runs successfully, else returns
false.

success

String. Error message if the service fails.error

pub.ibmp:setDefaultUser

Sets the default user for the system name specified in $connectionAlias.

Input Parameters

DescriptionParameter Name

String. Required. Fully qualified connection
name of the IBM Power system.

$connectionAlias

String. User ID to set as the default user for the
system name specified in $connectionAlias.

userId

Output Parameters

DescriptionParameter Name

String. Status of the service execution. Returns
true if the service runs successfully, else returns
false.

success

String. Error message if the service fails.error
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